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PSA Definition and Purpose

The Planetary Science Archive (PSA) is the initiative, the setup, the process and

the implementation to preserve data from ESA’s spacecraft to planetary bodies, as

well as supplementary information acquired in laboratories or ground-based

observatories.

The prime objectives of the PSA are:

! to support the experimenter teams in the preparation for the spacecraft and

ground-based long-term archives

! to enable and ensure the (long-term) preservation of these archives

! distribution of scientific useful data to the world wide scientific community

! provision of supplementary data services aiming to maximize the usage of

planetary mission data and ease the scientific data analysis.

The PSA will be advised by a PSA Scientific Advisory Group that meets at least

yearly.



The PDS Standard

! All PDS compatible data formats conform to a unified standard format incorporating

documentation, calibration, and raw and processed data files.

! The format distinguishes:

! Data files

!  The lowest level is that of the data files themselves. At this level each file will have a

PDS label either appended to the beginning of the file or, more often, in a separate but

proximate file. "One file, one label" is the general rule.

! Meta-data Files

!  At the intermediate level are files which describe the circumstances and parameters

of the data collection (for example: the instrument used, the observatory site, the type

of data collected, etc.). These files are called "catalog objects" or just "catalog" files.

! Volume/Dataset Description Files

!  These files are included on any distribution medium intended to be an entire, self-

contained archive - for example, a set of DVDs or a ZIP file. The volume description

files detail the organization of the data in the archive (in terms of directories, e.g.) and

any additional documentation and software which might be included.

! The PDS Standards are defined in the PDS Standards Reference Document.

! A Data Dictionary exists for the PDS and PSA which contains all keywords and values permitted

by the Standard.  Definitions of all keywords can be found here.  A useful online version is also

available.



The PDS Standard

! All PDS compatible data formats conform to a unified standard format incorporating

documentation, calibration, and raw and processed data files.

! The format distinguishes:

! Data files

!  The lowest level is that of the data files themselves. At this level each file will have a
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PDS_VERSION_ID                    = PDS3

/* FILE DATA ELEMENTS */

RECORD_TYPE                       = FIXED_LENGTH

RECORD_BYTES                      = 10420

FILE_RECORDS                      = 60291

LABEL_RECORDS                     = 2

/* POINTERS TO DATA OBJECTS */

^IMAGE_HEADER                     = 3

^IMAGE                            = 4

/* IDENTIFICATION DATA ELEMENTS */

FILE_NAME                         = "H0887_0000_ND2.IMG"

DATA_SET_ID                       = "MEX-M-HRSC-3-RDR-V2.0"

DETECTOR_ID                       = MEX_HRSC_NADIR

…

PROCESSING_LEVEL_ID               = 2

RELEASE_ID                        = 0012

REVISION_ID                       = 0000

/* TIME DATA ELEMENTS */

SPACECRAFT_CLOCK_START_COUNT      = "1/0044420119.56188"

SPACECRAFT_CLOCK_STOP_COUNT      = "1/0044420414.62539"

START_TIME                        = 2004-09-28T02:56:14.637Z

STOP_TIME                         = 2004-09-28T02:59:53.654Z

…

OBJECT                            = IMAGE

  INTERCHANGE_FORMAT              = BINARY

  LINES                           = 60288

  LINE_PREFIX_BYTES               = 68

  LINE_SAMPLES                    = 5176

  SAMPLE_TYPE                     = MSB_INTEGER

  SAMPLE_BITS                     = 16

  BANDS                           = 1

  BAND_STORAGE_TYPE               = BAND_SEQUENTIAL

  MAXIMUM                         = 206

  MEAN                            = 79.8813

  MINIMUM                         = 23

  STANDARD_DEVIATION              = 23.3757

END_OBJECT
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PDS_VERSION_ID                    = PDS3

LABEL_REVISION_NOTE               = "2004-09-28: JZ/ESA Draft 1"

RECORD_TYPE                       = FIXED_LENGTH

RECORD_BYTES                     = 80

RELEASE_ID                        = 0001

REVISION_ID                       = 0000

OBJECT                            = INSTRUMENT

 INSTRUMENT_HOST_ID               = MEX

 INSTRUMENT_ID                    = HRSC

 OBJECT                           = INSTRUMENT_INFORMATION

  INSTRUMENT_NAME                 = "HIGH RESOLUTION STEREO CAMERA"

  INSTRUMENT_TYPE                 = "CCD CAMERA"

  INSTRUMENT_DESC                = "

    Instrument Overview

    ===================

    The High Resolution Stereo Camera (HRSC), originally developed for the

    Russian-led Mars-96 mission, was selected as part of the Orbiter

    payload for ESA s Mars Express mission. The HRSC is a pushbroom

    scanning instrument with nine CCD line detectors mounted in parallel

    in the focal plane. Its unique feature is the ability to obtain

    near-simultaneous imaging data of a specific site at high resolution,

    with along-track triple stereo, four colours and five different

    phase angles, thus avoiding any time-dependent variations of the

    observational conditions. An additional Super-Resolution Channel (SRC)

    a framing device will yield nested images in the metre-resolution range

    for detailed photogeologic studies. The spatial resolution from the

    nominal periapsis altitude of 250 km will be 10 m px 1, with an image

    swath of 53 km, for the HRSC and 2.3 m px 1 for the SRC.

    During the mission s nominal operational lifetime of 1 martian year

    (2 Earth years) and assuming an average HRSC data transfer share of 40%,

    it will be possible to cover at least 50% of the martian surface at

    a spatial resolution of d 15 m px 1. More than 70% of the surface

    can be obser
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PDS Resources

! http://pds.jpl.nasa.gov

! More information on the PDS and

complete versions of the

Standards Reference and Data

Dictionary

! The Data Dictionary can be found

here

! Supporting Software Tools can

be downloaded here



PDS Resources
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! More information on the PDS and

complete versions of the

Standards Reference and Data
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! The Data Dictionary can be found

here
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A Few PDS Tools

! http://pds.jpl.nasa.gov

! Go to the Tools menu

! Click on Software Download

! NASA View

! A useful tool for visualising

labels and simple small data

products

! PDS Table Verifier

! A tool for reading tables and

enduring they are correctly

formatted



NASA View Example

! NASAView can open

simple PDS compliant

data

! Click on File -> Open

Object and select the

product you want to

see

! You can also click on

Label -> Full Label to

view the complete PDS

label with full

information on the

data product being

viewed



SBN IDL

! SBNIDL is an IDL package that is maintained and distributed by PDS's
Small Bodies Nodes.  It allows most PDS compliant products to be read
in to the IDL software.

! To retrieve the latest fully tested release or previous releases, check out
the page http://pdssbn.astro.umd.edu/nodehtml/software.shtml

! Within your IDLDE, select the File->Preferences and check that you path
contains the SBNIDL.



SBN IDL 2

! To run the SBNIDL you also need to have the astrolib library installed. If
not already done, you can retrieve the astrolib library at
http://idlastro.gsfc.nasa.gov/ .

! Read the aareadme.txt file distributed with the SBNIDL package. There is
no further way to test your installation than to call a procedure within
IDL. So, on your IDLDE command input, enter e.g.:

! If the routine READPDS is compiled successfully, your installation is ok.
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Step 1

a) Open the PSA www home page

at http://www.rssd.esa.int/psa

b) Select “ Classical User Interface”

on your left or in the yellow box

Step 3

The “ PSA Browser Start Page” will

appear on your screen and

will automatically start to

load

Step 2

a) You must click ‘Trust’ to accept the

certificate and run the PSA applet.



Login/Registering

Step 4

a) Select the “ Login/Register” View and

login or request new user id.

b) After having logged in, select the

“ Query Specification” View

The Planetary Science Archive (PSA) is

structured in 5 different ‘views’,

a) The “ Query Specification” view,

that allows you to define your

query against the database

b) The “ Latest Result” view, that

allows you to view the result of

your previous query.

c) The “ Shopping Basket” view, that

allows you to select your items of

interest and order them later (free of

charge).

d) The “ Login/Register”, that you

should know by now (if not, please

register to have the full

functionality of the PSA)

e) The “ Request Monitor” view to

monitor your requests

By clicking/selecting the individual views

you can ‘walk around’ in the PSA.



Define Your Query

Step 3

a) Open a “ Query Panel” and select your

search criteria

b) Select your “ Result Display” view

options

c) Execute the query

Not opening any “ Query Panel” will result

in the display of all available

datasets

In the “ Result Display” view options, you

can select to see Data Products,

Data Sets or both in the “ Result

Panel”

The PSA contains data conform to the

Planetary Data System Standard. A

‘Data Product’ is e.g. a PDS-

labeled file containing an image. A

‘Data Set’ is a full directory

hierarchy containing

documentation, catalogues,

indexes, data products and any

other information.

Opening several “ Query Panels” will

logically-AND the constraints

within the individual query panels.



Browse your Results and Select

Step 4

a) If you want individual data products,

‘view’ the products by clicking on

‘xxx Products’

b) If you want to download the whole

data set, ‘mark’ the dataset as selected

and move it to the Shopping Basket

Step 4:

c) ‘mark’ the data products that you want to

download as selected and move them

into the ‘Shopping’ Basket

Step 4 Alternative:

You can download a Data Products, associated

software and documentation directly,

using the ‘Retrieve’ menu on the left

side of each Data Product



Order via the Shopping Basket

Step 5:

a) ‘mark’ the Data Product that you want

to download and move it to the basket

b) You can then open the Shopping

Basket window

c) When you are happy with your

selections, click on ‘Submit Request’

To have a somewhat larger view of the data

product, click on the icon and it will be

displayed in a separate window.



Downloading / Retrieving the Data

Step 6:

a) ‘select’ your data packing option

b) ‘Confirm’ and wait for an email that

will inform you on the ftp retrieval of

the data  you have selected

Your email confirmation contains

all you need to know to download

the data within the next week

from the PSA server.
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Step 1

a) Open the PSA www home page

at http://www.rssd.esa.int/psa

b) Select “ Map-based User

Interface” on your left or in the

yellow box

Step 2

The “ PSA Browser Start Page” will

appear on your screen. Click

‘Start PSA Map’ to initiate

the applet.



Step 1

a) Define a Region of Interest (ROI)

by marking an area on the map

with your mouse.

b) A red-colored rectangle will be

visualize your ROI

c) Select your Instrument of choice

and, if required, an instrument

detector

d) Execute the query



Step 2

a) Analyze the footprint resulting from

your query

b) Select a footprint by moving the

mouse over it and pressing a mouse

button

Step 3

a) Select a service offered to you

a) View browse image, if available

b) Download data product

c) Download all documentation related to

this data product

Step 4

a) Clear your search, reselect a region of interest and

run your query



Option 1: Background map

! Select between several

background maps

! Load an own map via the

FILE entry of the Main

Menu.

Options

Option 2: visualize day night boundary

and the intersection of the Sun to

the center of Mars.

Option 3:  display a zoom window that

allows you to better select

individual data products

Option 4:   visualize a grid on top of your

background image



Map-based Interface vs Advanced Interface

Switch between the map-based interface to the advanced interface of the PSA and vice versa.

The results you receive from your queries from within the advanced interface are taken over to the map-based interface and displayed there in case of Mars data

for which geometry information is existing (HRSC, OMEGA) is available. This gives you the full flexibility of the advanced interface coupled to the

visual power of the map-based concept.
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Overview

! Direct Browsing of Datasets

! Data Downloads

! Accessing the PSA archive with an FTP-client

! Automatic Download Scripts / Mirror Scripts

! Your Comments



Step 1

a) Open the PSA www home page at http://www.rssd.esa.int/psa

b) Select “ Data set Browser Interface” on your left or in the yellow

box



Direct Browsing of Datasets

! From the Dataset Browser

entry page, select the

instrument of interest.

! Only public datasets are

available through this

interface! So you will not find

! Datasets before public

release

! Datasets in Peer Review



Direct Browsing of Datasets II

> Browse through the dataset in the usual

way.



Data Download

! When using a web browser, please insure to use

an appropriate method to download your data,

! E.g. in MOZILLA the ‘Save Link Target As…”

! Be aware that you download only the file selected,

…

! Detached label files (e.g. LBL and DAT) need to

be both downloaded to get the full data product!

! Any linked files, .e.g. ^DESCRIPTION =

“INSTRUMENT.PDF” will not be attached to the

downloaded file!



Accessing the PSA archive with an FTP-client

! You will be able to connect to the PSA archive with any ftp client, e.g. ncftp, ftp, fuqu, etc

! Using ftp://psa.esac.esa.int/pub/mirror

! Or directly the mission related subpage ftp://psa.esac.esa.int/pub/mirror/MARS-EXPRESS



Automatic Download Scripts / Mirror Scripts

! You can use any automatic download script (mirror, etc) to recursively download the data on the PSA.

! Before installing a regular download scheme on your side (mirror, etc), please inform us by sending a short note

to psahelp@rssd.esa.int. We will keep an eye on the load of network and server such that other users are not

disturbed. In such cases, we will contact you and propose alternative time periods and options to download the

data you are interested in.

! Be aware that the files that you see in your www-browser or your ftp-client are not the physical files, but a link

into the PSA database system. When downloading data, the PSA server resolves the link on the fly and delivers

the data back to you.

! When building mirror scripts, you can compare your data items against size or time with the ones on the PSA

server.

Be careful when using automatic downloads, as

the size of the datasets can be huge (several

100GBytes or larger)! Please contact the PSA

Helpdesk beforehand.
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Overview

! Registration

! Notification Rules

! Notification via Email

! Comments and Suggestions



Registration I

1. Goto Login Page

2. Login with your user id / password

3. Goto Login Page

4. Select ‘Change Notification Setting'



Registration II

Select             Add

         View     Return



Notification Rules

! Notification will be done shortly after

! A new dataset was ingested into the archive

! A new dataset release was ingested into the archive

! The ERRATA.TXT was modified, in other words an important piece of information about the

dataset was made available.

! Notification will be done using email service

! Ensure that your PSA account setting, especially your email address is correct

! You will be informed on the following changes:

You will be informed on any change relating to a

specific instrument.

SPECIFICSPECIFICSPECIFIC

You will be informed on any change relating to

data obtained from a specific spacecraft.

ALLSPECIFICSPECIFIC

You will be informed an any change relating to

data for a specific mission.

ALLALLSPECIFIC

You will be informed on any change in the

archive.

ALLALLALL

NotificationInstrumentInstrument Host

(Spacecraft)

Mission



Notification via Email

Once you have registered, you will receive e-mails with announcements of the new data in the

archive that you are interested in.



Comments and Suggestions

! Please send us your remarks psahelp@rssd.esa.int

! In case of problems, please visit the FAQ page before contacting us

! In case you can not find the data you are looking for, please read

the Mission Specific pages on the PSA home page

(http://www.rssd.esa.int/psa)


